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Part 1: User Journey Mapping 

 

Introduction 

Welcome to the AMIS Supervisor Tutorial. As a Supervisor, you have a dual role: you can create and 

implement your own activities like a Regular User, AND you oversee and approve activities implemented by 

your team members. This tutorial will guide you through both aspects of your role. 

Your Role and Responsibilities 

As a Supervisor, you are responsible for: 

 Team Oversight: Supervising workplans and activities assigned to you 

 Quality Assurance: Reviewing and approving activities submitted by action officers 
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 Feedback Provision: Providing constructive feedback to improve activity quality 

 Workplan Monitoring: Tracking progress of workplans under your supervision 

 Activity Implementation: Creating and implementing your own activities (like Regular Users) 

 Performance Management: Supporting team members to achieve their objectives 

 Data Quality: Ensuring accuracy and completeness of supervised activities 

Your Dual Role 

As an Implementer (Regular User Capabilities): 

 Create and implement your own activities 

 Submit your activities to YOUR supervisor for approval 

 Complete duty instructions assigned to you 

 View reports on your own activities 

As a Supervisor (Supervisory Capabilities): 

 Review activities submitted by your team members 

 Approve or send back activities for revision 

 Monitor workplans assigned to you 

 Provide guidance and feedback to action officers 

 View reports on supervised activities and workplans 

What You Can Do 

 All Regular User Features: Everything a Regular User can do 

 View Workplans: See workplans assigned to you for supervision 

 Supervise Activities: Review and approve activities from your team 

 Approve Activities: Approve activities that meet quality standards 

 Send Back for Revision: Request corrections when needed 

 Provide Feedback: Give constructive guidance to action officers 

 Monitor Progress: Track workplan and activity implementation 

 View Enhanced Reports: Access reports on supervised activities  

What You Cannot Do 

 Approve Your Own Activities: Your activities need approval from YOUR supervisor 

 Create Workplans: Only administrators can create workplans 

 Manage Users: Only administrators can manage user accounts 

 Evaluate Activities: Only evaluators can rate activities 
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 Access Admin Panel: Administrative functions are restricted 

 Manage SMEs: Only administrators can manage SMEs  

System Goal 

The primary objective of AMIS is to monitor and measure the effectiveness of activities implemented 

and how they contribute to achieving the targets in the plans. 

Your role as a Supervisor is crucial because you: 

 Ensure activities meet quality standards before approval 

 Provide guidance to improve implementation quality 

 Monitor progress toward workplan objectives 

 Support action officers in achieving results 

 Maintain data quality through thorough review 

 Enable evidence-based decision making 

 

Login Process 

Step 1: Access the AMIS Application 

1. Open your web browser (Chrome, Firefox, or Edge recommended) 

2. Navigate to the AMIS URL: http://your-amis-url.com (replace with your organization's URL) 

3. You'll see the AMIS Login page 

Step 2: Enter Your Credentials 

1. Email Address: Enter your registered email address 

2. Password: Enter your password 

3. Click the "Login" button 

Step 3: Successful Login 

Upon successful login: 

 You're redirected to your Dashboard Landing Page 

 You see a welcome message with your name 

 Your role badge shows "User" with "Supervisor" capability indicator 

 The sidebar navigation menu appears with your accessible features 

 You'll see additional menu items compared to Regular Users (Workplans, Supervised Activities) 
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Troubleshooting Login Issues 

Problem: "Invalid email or password" 

 Solution: Check your email and password are correct 

 Solution: Ensure Caps Lock is off 

 Solution: Contact your administrator to reset your password 

Problem: "Account not activated" 

 Solution: Check your email for activation link 

 Solution: Contact your administrator to activate your account 

Problem: "Session expired" 

 Solution: This is normal after 2 hours of inactivity 

 Solution: Simply log in again 

Security Best Practices 

 Change your password on first login 

 Use a strong password (at least 8 characters, mix of letters and numbers) 

 Don't share your password with anyone 

 Log out when finished, especially on shared computers 

 Report suspicious activity to your administrator 

 

Dashboard Overview 

After logging in, you land on your Dashboard Landing Page. As a Supervisor, your dashboard shows both 

your personal activity metrics AND your supervisory responsibilities. 

Dashboard Layout 

Top Section: Welcome Card 

 Welcome Message: "Welcome back, [Your Name]!" 

 Role Badge: Shows "User" with "Supervisor" indicator 

 Current Date and Time 

Main Section: Dashboard Widgets 
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The dashboard is organized into cards showing your key metrics: 

1. My Activities Card 

 Total Activities: Count of all YOUR activities (that you created) 

 Pending: Your activities you haven't implemented yet 

 Active: Your activities you're currently implementing 

 Submitted: Your activities awaiting YOUR supervisor's approval 

 Approved: Your activities approved by YOUR supervisor 

 Rated: Your activities evaluated by M&E staff 

 Quick Action: "Create New Activity" button 

2. Supervised Activities Card (Supervisor-Specific) 

 Total Supervised: Count of all activities assigned to you for supervision 

 Pending Approval: Activities submitted by your team awaiting YOUR approval 

 Approved by Me: Activities you've approved 

 Sent Back: Activities you've sent back for revision 

 Quick Action: "View Pending Approvals" button 

3. My Workplans Card (Supervisor-Specific) 

 Total Workplans: Count of workplans assigned to you for supervision 

 In Progress: Active workplans 

 Completion Rate: Average completion percentage 

 Quick Action: "View Workplans" button 

4. My Tasks Card 

 Pending Tasks: Duty instructions assigned to you 

 Completed Tasks: Duty instructions you've finished 

 Quick Action: "View All Tasks" button 

5. Recent Activities Card 

 List of your 5 most recent activities (both yours and supervised) 

 Shows activity title, type, status, and date 

 Quick Action: "View All Activities" button 

6. Team Performance Card (Supervisor-Specific) 

 Top Performers: Action officers with most approved activities 
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 Activities by Status: Distribution of supervised activities 

 Quick Action: "View Team Report" button 

Using the Dashboard 

Quick Navigation: 

 Click "Create New Activity" to start a new activity 

 Click "View Pending Approvals" to see activities awaiting your approval 

 Click "View Workplans" to see workplans you supervise 

 Click "View All Tasks" to see your duty instructions 

 Click on any recent activity to view its details 

Monitoring Your Responsibilities: 

 Check Pending Approval count to see activities needing your review (PRIORITY) 

 Check My Activities Submitted count to see your activities awaiting approval 

 Review Workplan Completion Rate to track progress 

 Monitor Team Performance to identify support needs 

Priority Actions: 

1. First: Review and approve pending activities (don't let them wait) 

2. Second: Implement and submit your own activities 

3. Third: Monitor workplan progress 

4. Fourth: Complete your duty instructions 

 

Navigation Map 

As a Supervisor, you have access to 6 main menu items in the left sidebar navigation: 

1. Dashboard 

 Icon:  Dashboard icon 

 Purpose: Your personal workspace with metrics and quick actions 

 Access: Always accessible 

 Supervisor Feature: Shows supervisory metrics (pending approvals, supervised activities) 
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2. My Activities 

 Icon:  Activities icon 

 Purpose: Create, view, implement, and manage YOUR OWN activities 

 Submenu Items: 

o All Activities: View all your activities 

o Create Activity: Create a new activity 

o Pending Activities: Filter to show pending activities 

o Active Activities: Filter to show active activities 

o Submitted Activities: Filter to show submitted activities 

 Note: This is for YOUR activities, not supervised activities 

3. Workplans (Supervisor-Specific) 

 Icon:  Workplans icon 

 Purpose: View and monitor workplans assigned to you for supervision 

 Submenu Items: 

o All Workplans: View all workplans you supervise 

o In Progress: Filter to show active workplans 

o Completed: Filter to show completed workplans 

 Access: Only supervisors can access this menu 

4. Supervised Activities (Supervisor-Specific) 

 Icon:  Supervised Activities icon 

 Purpose: Review, approve, and manage activities submitted by your team 

 Submenu Items: 

o All Supervised: View all activities you supervise 

o Pending Approval: Filter to show activities awaiting your approval (PRIORITY) 

o Approved: Filter to show activities you've approved 

o Sent Back: Filter to show activities you've sent back for revision 

 Access: Only supervisors can access this menu 

 Note: This is the MOST IMPORTANT menu for your supervisory role 

5. Duty Instructions 

 Icon:  Instructions icon 

 Purpose: View and manage duty instructions assigned to you 

 Submenu Items: 
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o All Instructions: View all your duty instructions 

o Pending Instructions: Filter to show pending tasks 

o Completed Instructions: Filter to show completed tasks 

6. Reports 

 Icon:  Reports icon 

 Purpose: View reports relevant to your work 

 Submenu Items: 

o My Activity Reports: Reports on YOUR activities 

o Supervised Activity Reports: Reports on activities you supervise (Supervisor-Specific) 

o Workplan Reports: Reports on workplans you supervise (Enhanced Access) 

o Statistics: View statistics dashboard (Enhanced Access) 

 Access: Enhanced access compared to Regular Users 

Top Navigation Bar 

Right Side: 

 User Profile Dropdown: Click your name to access: 

o My Profile: View and edit your profile 

o Change Password: Update your password 

o Logout: Sign out of the system 

Navigation Tips 

 Sidebar is collapsible: Click the menu icon to collapse/expand 

 Active menu is highlighted: Current page is shown in different color 

 Breadcrumbs: Top of page shows your current location 

 Back buttons: Use browser back or page-specific back buttons 

 Priority Menu: Check "Supervised Activities → Pending Approval" daily 

 

Typical Workflows 

As a Supervisor, here are your most common workflows: 

Workflow 1: Approving a Submitted Activity (MOST IMPORTANT) 

Scenario: An action officer submits an activity for your approval. 
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Steps: 

1. Receive Email Notification → Activity submitted for your review 

2. Dashboard → Check "Pending Approval" count 

3. Supervised Activities → Click "Pending Approval" filter 

4. View Activity → Click "View" on the submitted activity 

5. Review Implementation → Check all details, evidence, beneficiaries 

6. Make Decision: 

o If Quality is Good: Click "Approve" → Add positive remarks → Confirm 

o If Needs Improvement: Click "Send Back for Revision" → Add specific feedback → Confirm 

7. Email Sent → Action officer receives notification 

8. Activity Status Changes: 

o Approved → Status becomes "Approved" 

o Sent Back → Status becomes "Active" (action officer can revise) 

Timeline: Review within 1-3 days of submission 

Best Practice: Provide clear, constructive feedback whether approving or sending back 

Workflow 2: Monitoring Workplan Progress 

Scenario: You need to track progress of a workplan assigned to you. 

Steps: 

1. Workplans → View list of your workplans 

2. Select Workplan → Click "View" on a workplan 

3. Review Workplan Details: 

o Workplan title, dates, budget 

o List of activities within the workplan 

o Activity status distribution 

o Budget vs. cost analysis 

o Completion percentage 

4. Identify Issues: 

o Activities with status "Pending" (not yet implemented) 

o Activities with status "Active" (not yet submitted) 

o Delayed activities (past end date) 

o Budget overruns 

5. Take Action: 

o Contact action officers about delayed activities 

o Provide support for implementation challenges 
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o Review and approve submitted activities 

o Report progress to management 

6. Generate Report → Export workplan report for documentation 

Timeline: Review workplans weekly or bi-weekly 

Best Practice: Proactive monitoring prevents delays and ensures timely completion 

Workflow 3: Providing Feedback on Sent-Back Activity 

Scenario: You send an activity back for revision and the action officer resubmits. 

Steps: 

1. Initial Review → Activity doesn't meet quality standards 

2. Send Back for Revision → Provide specific, detailed feedback 

o List exactly what needs correction 

o Explain why it's important 

o Provide guidance on how to improve 

3. Action Officer Revises → Makes corrections based on your feedback 

4. Resubmission → Activity is submitted again 

5. Re-review → Check that corrections were made 

6. Verify Improvements: 

o Compare with original submission 

o Ensure all feedback points were addressed 

o Check quality of corrections 

7. Make Final Decision: 

o If Satisfactory: Approve with acknowledgment of improvements 

o If Still Inadequate: Send back again with additional guidance (rare) 

Timeline: Re-review within 1-2 days of resubmission 

Best Practice: Acknowledge improvements when approving after revision 

Workflow 4: Creating and Implementing Your Own Activities 

Scenario: You need to implement an activity yourself (you're also an implementer). 

Steps: 

1. My Activities → Click "Create New Activity" 

2. Fill Activity Form → Enter details, location, dates, budget 
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3. Assign Supervisor → Select YOUR supervisor (someone above you) 

4. Save Activity → Activity created with status "Pending" 

5. Implement Activity → Conduct field work 

6. Record Implementation → My Activities → View → Implement 

7. Fill Implementation Form → Enter details, upload evidence 

8. Save Implementation → Activity status changes to "Active" 

9. Submit for Review → Submit to YOUR supervisor 

10. Wait for Approval → YOUR supervisor reviews and approves 

11. Activity Approved → You receive email notification 

Timeline: Same as Regular User workflow 

Best Practice: Lead by example - maintain high quality in your own activities 

Workflow 5: Supporting Action Officers 

Scenario: An action officer needs guidance on activity implementation. 

Steps: 

1. Receive Request → Email, phone call, or in-person question 

2. Understand the Issue: 

o What activity type? 

o What specific challenge? 

o What has been tried? 

3. Provide Guidance: 

o Explain requirements clearly 

o Share examples of good implementations 

o Offer practical solutions 

o Provide resources or contacts 

4. Follow Up: 

o Check if guidance was helpful 

o Offer additional support if needed 

o Review the activity when submitted 

5. Document Learning: 

o Note common issues for training 

o Share best practices with team 

o Update guidance documents 

Timeline: Respond to requests within 24 hours 
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Best Practice: Be approachable and supportive - your team's success is your success 

 

User Journey Diagram 
┌─────────────────────────────────────────────────────────────────┐ 
│                         LOGIN PAGE                               │ 
│                    Enter Email & Password                        │ 
└────────────────────────┬────────────────────────────────────────┘ 
                         │ 
                         ▼ 
┌─────────────────────────────────────────────────────────────────┐ 
│                    SUPERVISOR DASHBOARD                          │ 
│  ┌──────────────┐  ┌──────────────┐  ┌──────────────┐          │ 
│  │ My Activities│  │  Supervised  │  │ My Workplans │          │ 
│  │              │  │  Activities  │  │              │          │ 
│  └──────────────┘  └──────────────┘  └──────────────┘          │ 
│                    ┌──────────────┐                             │ 
│                    │PENDING       │  ← PRIORITY!                │ 
│                    │APPROVALS: 5  │                             │ 
│                    └──────────────┘                             │ 
└────────┬────────────────┬────────────────┬───────────────────────┘ 
         │                │                │ 
    ┌────▼─────┐    ┌────▼─────┐    ┌────▼─────┐ 
    │   My     │    │Supervised│    │Workplans │ 
    │Activities│    │Activities│    │          │ 
    │(Create & │    │(Approve) │    │(Monitor) │ 
    │Implement)│    │          │    │          │ 
    └──────────┘    └────┬─────┘    └──────────┘ 
                         │ 
                         ▼ 
    ┌────────────────────────────────────────┐ 
    │  SUPERVISED ACTIVITIES                 │ 
    │  Filter: PENDING APPROVAL              │ 
    │  - Activity 1 (Training)               │ 
    │  - Activity 2 (Input Distribution)     │ 
    │  - Activity 3 (Meeting)                │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  VIEW ACTIVITY DETAILS                 │ 
    │  - Review implementation               │ 
    │  - Check evidence (photos, docs)       │ 
    │  - Verify beneficiary data             │ 
    │  - Assess quality                      │ 
    └────┬───────────────────────────────────┘ 
         │ 
         ▼ 
    ┌────────────────────────────────────────┐ 
    │  MAKE DECISION                         │ 
    │  ┌──────────────┐  ┌─────────────────┐│ 
    │  │   APPROVE    │  │  SEND BACK FOR  ││ 
    │  │              │  │    REVISION     ││ 
    │  └──────┬───────┘  └────────┬────────┘│ 
    └─────────┼──────────────────┼──────────┘ 
              │                  │ 
              ▼                  ▼ 
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    ┌─────────────────┐  ┌──────────────────┐ 
    │  APPROVED       │  │  SENT BACK       │ 
    │  Status:        │  │  Status: ACTIVE  │ 
    │  APPROVED       │  │  + Feedback      │ 
    │  ↓              │  │  ↓               │ 
    │  Email to       │  │  Email to        │ 
    │  Action Officer │  │  Action Officer  │ 
    │  ↓              │  │  ↓               │ 
    │  Ready for      │  │  Action Officer  │ 
    │  Evaluation     │  │  Revises         │ 
    └─────────────────┘  └────────┬─────────┘ 
                                  │ 
                                  ▼ 
                         ┌─────────────────┐ 
                         │  RESUBMITTED    │ 
                         │  Status:        │ 
                         │  SUBMITTED      │ 
                         │  ↓              │ 
                         │  Re-review      │ 
                         └─────────────────┘ 

 

Access Permissions Summary 

What You CAN Access 

Feature Access Level Description 

Dashboard Full Access Your personal dashboard with supervisory metrics 

My Activities Full Access Create, view, implement, submit YOUR activities 

Workplans View & Monitor View and monitor workplans assigned to you 

Supervised Activities Full Access Review, approve, send back activities from your team 

Duty Instructions View Only View duty instructions assigned to you 

Reports Enhanced Access View reports on your activities AND supervised activities 

Profile Management Full Access Update your personal information 

What You CANNOT Access 

Feature Restriction Who Can Access 

Admin Panel No Access Administrators only 

User Management No Access Administrators only 
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Feature Restriction Who Can Access 

Workplan Creation No Access Administrators only 

SME Management No Access Administrators only 

Evaluation No Access Evaluators only 

Activity Rating No Access Evaluators only 

Activity Permissions 

Action Your Activities Supervised Activities 

Create Activity  Yes N/A 

View Activities  Yes (own only)  Yes (all supervised) 

Implement Activities  Yes (own only)  No 

Submit for Review  Yes (own only) N/A 

Approve Activities  No (own activities)  Yes (supervised activities) 

Send Back for Revision  No (own activities)  Yes (supervised activities) 

Delete Pending Activities  Yes (own only)  No 

Edit Active Activities  Yes (own only)  No 

Workplan Permissions 

Action Permission 

View Workplans  Yes (assigned to you) 

Create Workplans  No (Admin only) 

Edit Workplans  No (Admin only) 

Monitor Progress  Yes 

View Activities in Workplan  Yes 

Generate Workplan Reports  Yes 
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Report Permissions 

Report Type Access 

My Activity Reports  Full Access 

Supervised Activity Reports  Full Access (Supervisor-Specific) 

Workplan Reports  Enhanced Access (workplans you supervise) 

Statistics Dashboard  Enhanced Access (your data + supervised data) 

Corporate Plan Reports  No Access 

HR Reports  No Access 

MTDP Reports  Limited Access 

NASP Reports  Limited Access 

 

Part 2: Feature-by-Feature Documentation 

 

Activity Management Features 

As a Supervisor, you have all the activity management capabilities of a Regular User. You can create, 

implement, and submit your own activities. 

Feature: Activity Creation & Management (Your Own Activities) 

Feature Description: 

As a Supervisor, you can create and manage your own activities just like a Regular User. These are activities 

that YOU will implement in the field. You must submit these to YOUR supervisor for approval. 

Important Note: This section covers YOUR OWN activities. For activities submitted by your team 

members, see the "Supervised Activities Features" section. 

Purpose and Benefits: 

 Allows you to implement activities in addition to supervisory duties 

 Demonstrates leadership by example 

 Contributes to workplan objectives 
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 Maintains your field implementation skills 

 Provides firsthand understanding of implementation challenges 

How to Access This Feature: 

1. From Dashboard, click "My Activities" in the left sidebar 

2. Click "Create Activity" button 

How to Use This Feature: 

The process is identical to Regular Users. Please refer to the Regular User Tutorial for detailed instructions 

on: 

 Creating activities 

 Implementing activities (all 7 types) 

 Submitting activities for review 

 Responding to supervisor feedback 

Key Differences for Supervisors: 

 You assign YOUR supervisor (not yourself) when creating activities 

 You CANNOT approve your own activities 

 Your activities go through the same approval process as regular users 

 You should maintain high quality standards to set an example for your team 

Additional Important Information: 

Tips and Best Practices: 

 Lead by example - maintain high quality in your own activities 

 Balance your time - don't neglect supervisory duties for implementation 

 Use your experience - apply lessons learned from reviewing others' activities 

 Be timely - submit your activities promptly to avoid delays 

 Share learnings - discuss challenges with your team 

Common Mistakes to Avoid: 

 Don't try to approve your own activities (system prevents this) 

 Don't neglect your supervisory duties to focus on your own activities 

 Don't set lower standards for yourself than for your team 

Permissions: 



AMIS – TUTORIAL 

17 | Page BY: Noland Gande V 2.0 10-2025 

 

 As Supervisor: You have the same permissions for YOUR activities as Regular Users 

 You cannot approve your own activities 

 You must submit to YOUR supervisor 

 

Workplan Management Features 

Workplans organize related activities into coordinated work programs. As a Supervisor, you monitor 

workplans assigned to you. 

Feature: Viewing and Monitoring Workplans 

Feature Description: 

The Workplan Viewing and Monitoring feature allows you to track progress of workplans assigned to you 

for supervision. You can view workplan details, monitor activity implementation, track budget utilization, 

and identify issues requiring intervention. 

Purpose and Benefits: 

 Provides overview of coordinated work programs 

 Tracks progress toward workplan objectives 

 Monitors budget vs. cost 

 Identifies delayed or stalled activities 

 Enables proactive intervention 

 Supports resource allocation decisions 

 Facilitates progress reporting to management 

How to Access This Feature: 

1. From Dashboard, click "Workplans" in the left sidebar 

2. You'll see the Workplans Index page with workplans assigned to you 

3. Click "View" on any workplan to see details 

How to Use This Feature: 

Viewing Your Workplans 

From Workplans Index: 

1. Navigate to Workplans 

2. View list of all workplans assigned to you for supervision 
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3. See workplan details in table: 

o Workplan Code 

o Workplan Title 

o Branch 

o Start Date 

o End Date 

o Status 

o Activity Count 

o Budget 

o Cost 

o Completion % 

o Actions (View) 

Using Filters: 

 Status Filter: Show Draft, In Progress, Completed, or On Hold 

 Date Range Filter: Show workplans within date range 

 Search Box: Search by workplan title or code 

Sorting: 

 Click column headers to sort 

 Click again to reverse sort order 

 Sort by completion % to identify lagging workplans 

Viewing Workplan Details 

1. From Workplans Index, click "View" button on a workplan 

2. Workplan Details page shows: 

Section 1: Workplan Information 

 Workplan code, title, description 

 Start and end dates 

 Status 

 Budget allocated 

 Cost incurred 

 Budget utilization % 

 Completion percentage 

 Branch 

 Supervisor (you) 
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Section 2: Activities List 

 All activities within the workplan 

 Activity details: 

o Activity code and title 

o Type 

o Status 

o Action Officer 

o Start and end dates 

o Budget and cost 

o Actions (View, Approve if submitted) 

Section 3: Activity Status Distribution 

 Pie chart showing activities by status 

 Counts for each status: 

o Pending (not yet implemented) 

o Active (implemented, not submitted) 

o Submitted (awaiting your approval) 

o Approved (approved by you) 

o Rated (evaluated) 

Section 4: Budget vs. Cost Analysis 

 Bar chart comparing budget to actual cost 

 Budget utilization percentage 

 Identifies over/under spending 

Section 5: Timeline Visualization 

 Gantt chart or timeline showing activity dates 

 Identifies overlapping activities 

 Shows delayed activities (past end date) 

Monitoring Workplan Progress 

Key Metrics to Monitor: 

1. Completion Percentage 

o Calculated as: (Approved + Rated Activities) ÷ Total Activities × 100 

o Target: Should increase steadily over time 

o Action if low: Identify bottlenecks, support action officers 
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2. Budget Utilization 

o Calculated as: Cost Incurred ÷ Budget Allocated × 100 

o Target: Should align with completion percentage 

o Action if >100%: Investigate overspending 

o Action if <<Completion%: Costs may not be recorded 

3. Activities by Status 

o High Pending count: Activities not yet implemented - follow up with action officers 

o High Active count: Activities implemented but not submitted - remind action officers to submit 

o High Submitted count: Activities awaiting your approval - PRIORITY for you to review 

o High Approved count: Good progress - activities ready for evaluation 

4. Delayed Activities 

o Activities past their end date but not approved 

o Action: Contact action officers, provide support, escalate if needed 

Taking Action Based on Monitoring 

If Activities are Delayed: 

1. Identify which activities are delayed 

2. Contact action officers to understand reasons 

3. Provide support or resources if needed 

4. Adjust timelines if necessary (contact administrator) 

5. Escalate to management if issues persist 

If Budget is Overspent: 

1. Review cost details for each activity 

2. Identify activities with high costs 

3. Verify costs are accurate and justified 

4. Discuss with action officers 

5. Report to management for budget adjustment if needed 

If Completion Rate is Low: 

1. Analyze which activities are stuck 

2. Identify common bottlenecks 

3. Provide targeted support 

4. Consider reassigning activities if needed 

5. Report progress and challenges to management 

How This Feature Appears in Reports: 
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Workplan data appears in: 

1. Workplan Reports 

o Complete workplan details 

o Activity breakdown 

o Budget vs. cost analysis 

o Completion metrics 

o Timeline visualization 

2. Statistics Dashboard 

o Workplan counts and metrics 

o Workplan trends over time 

o Your supervised workplans highlighted 

Additional Important Information: 

Tips and Best Practices: 

 Review workplans weekly to stay on top of progress 

 Identify issues early - proactive intervention prevents delays 

 Communicate regularly with action officers 

 Use filters to focus on specific workplans 

 Export reports for management updates 

 Celebrate milestones when workplans reach completion targets 

 Document lessons learned for future workplans 

Common Mistakes to Avoid: 

 Don't wait until end date to check progress 

 Don't ignore low completion rates 

 Don't overlook budget overruns 

 Don't forget to follow up on delayed activities 

 Don't micromanage - provide support, not control 

Troubleshooting: 

 No workplans showing: You may not be assigned as supervisor for any workplans 

 Can't view workplan details: Contact administrator if access issues 

 Completion % seems wrong: Check if activities are being approved 

 Budget data missing: Action officers may not have recorded costs 

Related Features: 
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 Supervised Activities: Approve activities within workplans 

 Workplan Reports: Detailed reporting on workplan progress 

 Dashboard: Quick view of workplan metrics 

Permissions: 

 As Supervisor: You can view and monitor workplans assigned to you 

 You cannot create or edit workplans (administrator only) 

 You can approve activities within your workplans 

 

Supervised Activities Features 

This is the MOST IMPORTANT feature for your supervisory role. Here you review, approve, and provide 

feedback on activities submitted by your team members. 

Feature: Reviewing and Approving Supervised Activities 

Feature Description: 

The Supervised Activities feature allows you to view all activities assigned to you for supervision, review 

implementation details, approve activities that meet quality standards, and send back activities that need 

improvement with constructive feedback. 

Purpose and Benefits: 

 Ensures activities meet quality standards before approval 

 Provides quality control for data integrity 

 Enables constructive feedback to improve implementation 

 Supports action officer development 

 Maintains accountability for results 

 Creates audit trail of approvals 

 Facilitates evidence-based decision making 

How to Access This Feature: 

1. From Dashboard, click "Supervised Activities" in the left sidebar 

2. You'll see the Supervised Activities Index page with all activities assigned to you 

3. Use filters to focus on specific activities (especially "Pending Approval") 

How to Use This Feature: 
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Viewing Supervised Activities 

From Supervised Activities Index: 

1. Navigate to Supervised Activities 

2. View list of all activities where you're assigned as supervisor 

3. See activity details in table: 

o Activity Code 

o Activity Title 

o Type 

o Status 

o Action Officer 

o Start Date 

o End Date 

o Budget 

o Cost 

o Actions (View, Approve, Send Back) 

Using Filters (IMPORTANT): 

 Status Filter: 

o Pending Approval - Activities awaiting YOUR review (PRIORITY) 

o Approved - Activities you've approved 

o Sent Back - Activities you've sent back for revision 

o All - All supervised activities 

 Activity Type Filter: Filter by type (7 types) 

 Action Officer Filter: Filter by specific action officer 

 Date Range Filter: Filter by activity dates 

 Search Box: Search by activity title or code 

Priority Focus: 

 Always check "Pending Approval" first - these need your immediate attention 

 Aim to review within 1-3 days of submission 

Reviewing an Activity 

Step 1: Access Activity Details 

1. From Supervised Activities, filter by "Pending Approval" 

2. Click "View" button on an activity 
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3. Activity Details page opens 

Step 2: Review Activity Information 

Basic Information: 

 Activity code, title, description 

 Activity type 

 Target output 

 Location (province, district, LLG, village) 

 GPS coordinates 

 Start and end dates 

 Budget allocated 

 Strategic plan linkages (MTDP, NASP, Corporate Plan) 

Implementation Information: 

 Review type-specific implementation details 

 Check all required fields are filled 

 Verify data is complete and accurate 

Step 3: Review Evidence 

For All Activity Types: 

 Photos: Check quality, relevance, and clarity 

o Do photos clearly show the activity? 

o Are there enough photos (minimum 3-5)? 

o Do photos match the description? 

 Documents: Review uploaded files 

o Are all required documents uploaded? 

o Are documents readable and complete? 

o Do documents support the implementation? 

For Specific Activity Types: 

Documents: 

 Check document file is uploaded 

 Verify document title and description match 

 Review distribution information 

Trainings: 
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 Review participant list (names, gender, age, villages) 

 Check participant count is realistic 

 Verify training photos show participants 

 Review signing sheet for signatures 

 Check training materials are uploaded 

Meetings: 

 Review participant list (names, organizations, positions) 

 Check meeting agenda and minutes 

 Verify decisions and action items are recorded 

 Review meeting attachments 

Agreements: 

 Review agreement document (signed) 

 Check signing parties information 

 Verify agreement dates are logical 

 Review agreement terms 

Inputs: 

 Review beneficiary list (names, gender, villages, inputs received) 

 Check beneficiary count is realistic 

 Verify distribution photos show beneficiaries 

 Check signed beneficiary list is uploaded 

 Verify quantities add up correctly 

Infrastructures: 

 Review construction photos (before, during, after) 

 Check technical specifications are complete 

 Verify contractor information 

 Review completion certificate 

 Check cost breakdown is detailed 

Outputs: 

 Review output evidence 

 Check target vs. actual achievement 

 Verify quality assessment 

 Review verification documents 
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Step 4: Review Beneficiary Data 

For activities with beneficiaries (Trainings, Inputs, etc.): 

 Check beneficiary count is realistic 

 Verify names are not duplicates 

 Check gender distribution is recorded 

 Verify villages/communities are specified 

 Ensure data matches signing sheets/distribution lists 

Red Flags: 

 Suspiciously round numbers (e.g., exactly 100 beneficiaries) 

 Duplicate names 

 Missing gender or village information 

 Beneficiary count doesn't match photos 

 No signing sheet or distribution list 

Step 5: Review Cost Information 

 Check actual cost is recorded 

 Verify cost is realistic for the activity 

 Compare cost to budget 

 Check cost breakdown if provided 

 Identify significant over/under spending 

Cost Assessment: 

 If cost > budget: Verify overspending is justified 

 If cost << budget: Check if all costs were recorded 

 If cost = 0: Remind action officer to record costs 

Step 6: Assess Overall Quality 

Quality Checklist: 

  All required fields are filled 

  Description is clear and detailed 

  Evidence (photos, documents) is complete 

  Beneficiary data is accurate and realistic 

  Cost information is recorded 

  Implementation matches the activity plan 
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  Strategic plan linkages are appropriate 

  Location information is accurate 

Quality Levels: 

 Excellent: All criteria met, high-quality evidence, detailed information 

 Good: All criteria met, adequate evidence, complete information 

 Acceptable: All criteria met, minimum evidence, basic information 

 Needs Improvement: Some criteria not met, missing evidence, incomplete information 

Approving an Activity 

When to Approve: 

 All required information is complete 

 Evidence is adequate and supports implementation 

 Beneficiary data is realistic and accurate 

 Cost information is recorded 

 Quality meets acceptable standards or higher 

Step 1: Click "Approve" Button 

 Located on Activity Details page 

 Opens approval confirmation dialog 

Step 2: Add Approval Remarks (Optional but Recommended) 

What to Include: 

 Positive feedback on what was done well 

 Acknowledgment of good quality evidence 

 Recognition of impact achieved 

 Any observations or suggestions for future activities 

Example Remarks: 

 "Excellent implementation with comprehensive evidence. Well done!" 

 "Good quality training with detailed participant list and clear photos. Approved." 

 "Activity meets all requirements. Good work on documenting beneficiaries." 

 "Approved. Consider adding more photos in future activities for better documentation." 

Step 3: Click "Confirm Approval" 
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 Activity status changes to "Approved" 

 Approval timestamp and your name are recorded 

 Email notification sent to action officer 

 Activity is now ready for evaluation 

 Success message confirms approval 

Step 4: Activity Moves Forward 

 Action officer receives email notification 

 Activity appears in "Approved" filter 

 Evaluator can now rate the activity 

 Activity contributes to workplan completion metrics 

Sending Back for Revision 

When to Send Back: 

 Required information is missing or incomplete 

 Evidence is inadequate or missing 

 Beneficiary data is unrealistic or suspicious 

 Cost information is missing 

 Quality does not meet acceptable standards 

 Implementation doesn't match the activity plan 

Step 1: Click "Send Back for Revision" Button 

 Located on Activity Details page 

 Opens send back dialog 

Step 2: Add Detailed Feedback (REQUIRED) 

What to Include: 

 Specific issues: List exactly what needs correction 

 Why it matters: Explain why each issue is important 

 How to fix: Provide guidance on making corrections 

 Examples: Give examples of what you're looking for 

 Encouragement: Be constructive and supportive 

Example Feedback: 

Poor Feedback (Don't do this): 
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 "Not good enough. Fix it." 

 "Missing information." 

 "Needs improvement." 

Good Feedback (Do this): 

 "Please make the following corrections: 

1. Upload training photos - I need to see at least 5 photos showing participants during the training 

sessions. 

2. Add participant list - The participant list is missing. Please upload the signed attendance sheet. 

3. Record actual cost - The cost field is empty. Please enter the total amount spent on this training. 

4. Improve description - The description is too brief. Please add details about what topics were 

covered and what participants learned. 

These items are important for documenting the impact of the training and for evaluation. Please 

resubmit after making these corrections. Let me know if you need any help." 

Feedback Template: 

Please make the following corrections: 
 
1. [Issue 1]: [Specific correction needed] 
   Why: [Explanation] 
   How: [Guidance] 
 
2. [Issue 2]: [Specific correction needed] 
   Why: [Explanation] 
   How: [Guidance] 
 
3. [Issue 3]: [Specific correction needed] 
   Why: [Explanation] 
   How: [Guidance] 
 
Please resubmit after making these corrections. Contact me if you need clarification or 
support. 

Step 3: Click "Confirm Send Back" 

 Activity status changes back to "Active" 

 Your feedback is saved and visible to action officer 

 Email notification sent to action officer with your remarks 

 Action officer can now edit and resubmit 

 Activity appears in "Sent Back" filter 

Step 4: Action Officer Revises 

 Action officer receives email with your feedback 
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 They make corrections based on your guidance 

 They resubmit the activity 

 Activity status changes to "Submitted" again 

 You receive email notification of resubmission 

Step 5: Re-review the Activity 

 Review the resubmitted activity 

 Check that all corrections were made 

 Verify improvements address your feedback 

 Make final decision (approve or send back again if still inadequate) 

Tracking Your Approval Activity 

From Supervised Activities: 

 Use "Approved" filter to see activities you've approved 

 Use "Sent Back" filter to see activities you've sent back 

 Monitor resubmissions of sent-back activities 

From Dashboard: 

 Pending Approval count shows activities awaiting your review 

 Approved by Me count shows activities you've approved 

 Sent Back count shows activities you've sent back 

How This Feature Appears in Reports: 

Supervised activities appear in: 

1. Supervised Activity Reports 

o List of all activities you supervise 

o Approval status and dates 

o Your approval remarks 

o Action officer performance metrics 

2. Workplan Reports 

o Activities you've approved contribute to workplan metrics 

o Approval rates by workplan 

3. Statistics Dashboard 

o Your approval activity metrics 

o Approval rates and trends 

Additional Important Information: 
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Tips and Best Practices: 

 Review promptly - don't let activities wait more than 3 days 

 Be thorough - check all evidence and data carefully 

 Be fair - apply consistent standards to all action officers 

 Be constructive - provide helpful feedback, not just criticism 

 Be specific - list exactly what needs correction 

 Be encouraging - recognize good work and improvements 

 Communicate - be available for questions and clarification 

 Document - add remarks even when approving 

 Follow up - check that sent-back activities are resubmitted 

 Learn - identify common issues for training opportunities 

Common Mistakes to Avoid: 

 Don't approve without reviewing evidence 

 Don't send back without specific, detailed feedback 

 Don't be too lenient (approving poor quality) 

 Don't be too strict (sending back for minor issues) 

 Don't delay approvals unnecessarily 

 Don't use vague feedback like "needs improvement" 

 Don't forget to check beneficiary data 

 Don't ignore missing cost information 

 Don't approve activities you haven't actually reviewed 

Troubleshooting: 

 Can't see supervised activities: Check you're assigned as supervisor 

 Can't approve activity: Check activity status is "Submitted" 

 Approval not saving: Refresh page and try again 

 Email not sent: Check action officer's email address 

 Activity still showing after approval: Refresh page or clear filters 

Related Features: 

 Workplan Management: Activities you approve contribute to workplan progress 

 Activity Management: Understanding implementation helps you review better 

 Reports: Your approval activity is tracked in reports 

Permissions: 
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 As Supervisor: You can approve activities assigned to you for supervision 

 You cannot approve your own activities 

 You can send back activities for revision 

 You can view all details of supervised activities 

Email Notifications: 

 On submission: You receive email when activity is submitted 

 On approval: Action officer receives email 

 On send back: Action officer receives email with your remarks 

Business Logic: 

 Only "Submitted" activities can be approved or sent back 

 Approval changes status to "Approved" 

 Send back changes status to "Active" 

 Remarks are required when sending back 

 Remarks are optional when approving (but recommended) 

 Approval is final - you cannot unapprove (contact administrator if needed) 

 

Duty Instructions Features 

Duty Instructions are specific tasks assigned to you. As a Supervisor, you receive duty instructions just like 

Regular Users. 

Feature: Viewing and Managing Duty Instructions 

Feature Description: 

Duty Instructions provide a system for receiving and tracking work assignments. Each duty instruction 

contains multiple instruction items (specific tasks) that you need to complete. 

Purpose and Benefits: 

 Provides clear task assignments 

 Sets expectations for your work 

 Establishes deadlines 

 Enables task-level tracking 

 Supports accountability 

 Facilitates communication with your supervisor 
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How to Access This Feature: 

1. From Dashboard, click "Duty Instructions" in the left sidebar 

2. You'll see the Duty Instructions Index page with all instructions assigned to you 

How to Use This Feature: 

The process is identical to Regular Users. Please refer to the Regular User Tutorial for detailed instructions 

on: 

 Viewing duty instructions 

 Reviewing instruction items 

 Completing tasks 

 Reporting completion 

Key Points for Supervisors: 

 You receive duty instructions from YOUR supervisor 

 Complete duty instructions alongside your supervisory duties 

 Prioritize based on deadlines and importance 

 Report completion promptly 

Additional Important Information: 

Tips and Best Practices: 

 Balance your time - manage supervisory duties and assigned tasks 

 Prioritize - urgent approvals may take precedence over some tasks 

 Communicate - inform your supervisor if you need deadline extensions 

 Delegate - if appropriate, involve your team in completing tasks 

 

Reporting Features 

Reports provide insights into your work and your team's performance. As a Supervisor, you have enhanced 

access to reports. 

Feature: Viewing Reports (Enhanced Access) 

Feature Description: 
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The Reporting feature allows you to view various reports about your activities, supervised activities, 

workplans, and team performance. Reports help you track progress, demonstrate achievements, and identify 

areas for improvement. 

Purpose and Benefits: 

 Tracks your activity implementation progress 

 Monitors supervised activity performance 

 Shows workplan progress and completion 

 Demonstrates team achievements 

 Identifies areas for improvement 

 Supports performance reviews 

 Provides data for management reporting 

How to Access This Feature: 

1. From Dashboard, click "Reports" in the left sidebar 

2. Select the type of report you want to view: 

o My Activity Reports - Your own activities 

o Supervised Activity Reports - Activities you supervise (Supervisor-Specific) 

o Workplan Reports - Workplans you supervise (Enhanced Access) 

o Statistics - Your data + supervised data (Enhanced Access) 

How to Use This Feature: 

Viewing My Activity Reports 

Purpose: Track YOUR OWN activities (that you created and implemented) 

Steps: 

1. Navigate to Reports → My Activity Reports 

2. Apply filters (date range, type, status) 

3. Click "Generate Report" 

4. Review your activity metrics and details 

5. Export PDF if needed 

What You See: 

 Your activities only 

 Activity status distribution 

 Budget vs. cost for your activities 

 Your performance metrics 
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Viewing Supervised Activity Reports (Supervisor-Specific) 

Purpose: Track activities submitted by your team members 

Steps: 

1. Navigate to Reports → Supervised Activity Reports 

2. Apply filters: 

o Date Range 

o Activity Type 

o Action Officer (specific team member) 

o Status 

3. Click "Generate Report" 

4. Review supervised activity metrics 

What You See: 

 All activities you supervise 

 Approval status distribution 

 Activities by action officer 

 Team performance metrics 

 Approval rates and timelines 

 Quality indicators 

Key Metrics: 

 Total Supervised Activities: Count of all activities assigned to you 

 Approval Rate: % of submitted activities you've approved 

 Average Review Time: Average days from submission to approval 

 Sent Back Rate: % of activities sent back for revision 

 Activities by Action Officer: Performance comparison 

 Activities by Type: Distribution across 7 types 

 Budget vs. Cost: Financial performance 

Using the Report: 

 Identify top performers: Action officers with high approval rates 

 Identify support needs: Action officers with high sent-back rates 

 Track trends: Improvement over time 

 Recognize achievements: Share successes with team 

 Plan training: Address common quality issues 
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Viewing Workplan Reports (Enhanced Access) 

Purpose: Track progress of workplans you supervise 

Steps: 

1. Navigate to Reports → Workplan Reports 

2. Apply filters: 

o Date Range 

o Status 

o Specific Workplan 

3. Click "Generate Report" 

4. Review workplan metrics 

What You See: 

 Workplans you supervise 

 Workplan completion percentages 

 Activity breakdown by workplan 

 Budget vs. cost by workplan 

 Timeline visualization 

 Status distribution 

Key Metrics: 

 Workplan Completion %: Progress toward completion 

 Budget Utilization %: Spending vs. budget 

 Activities by Status: Implementation progress 

 Delayed Activities: Activities past end date 

 Approval Backlog: Submitted activities awaiting approval 

Viewing Statistics Dashboard (Enhanced Access) 

Purpose: View real-time analytics of your work and supervised activities 

Steps: 

1. Navigate to Reports → Statistics 

2. Apply filters (date range) 

3. Review dashboard sections 

What You See: 
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 Your Activities: Metrics for activities you created 

 Supervised Activities: Metrics for activities you supervise 

 Workplans: Metrics for workplans you supervise 

 Team Performance: Top performers and trends 

 Charts: Visual representations of data 

Key Sections: 

 Summary cards (activity counts, costs) 

 Status breakdown (pending, active, submitted, approved, rated) 

 Activity type distribution 

 Monthly trends 

 Top action officers 

 Approval activity trends 

How This Feature Appears in Reports: 

Reports are the feature itself - they display your data and supervised data in various formats. 

Additional Important Information: 

Tips and Best Practices: 

 Review reports weekly to track progress 

 Use supervised activity reports to identify team support needs 

 Export reports for management updates 

 Share reports with your team for transparency 

 Use filters to focus on specific periods or action officers 

 Track trends over time to measure improvement 

 Celebrate successes shown in reports 

Common Mistakes to Avoid: 

 Don't forget to apply filters before exporting 

 Don't ignore low performance indicators 

 Don't use reports to punish - use them to support 

 Don't export without reviewing data first 

Troubleshooting: 

 No data showing: Check filters aren't too restrictive 

 Export fails: Check browser pop-up blocker 
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 Charts not displaying: Refresh page or check browser 

 Slow loading: Reduce date range 

Related Features: 

 Supervised Activities: Data feeds into reports 

 Workplan Management: Workplan data feeds into reports 

 Dashboard: Quick view of key metrics 

Permissions: 

 As Supervisor: You see YOUR activities + SUPERVISED activities 

 You cannot see other supervisors' data 

 You have enhanced access compared to Regular Users 

 

Dashboard Features 

Your dashboard is your command center showing both your personal work and your supervisory 

responsibilities. 

Feature: Supervisor Dashboard Metrics 

Feature Description: 

The Supervisor Dashboard provides real-time metrics about your activities, supervised activities, workplans, 

and team performance, with quick access to key features. 

Purpose and Benefits: 

 Instant visibility of your work and team status 

 Quick access to priority actions (pending approvals) 

 Tracks your pending and completed work 

 Shows team performance at a glance 

 Motivates through progress visualization 

 Supports daily work planning 

How to Access This Feature: 

 Automatically displayed after login 

 Click "Dashboard" in left sidebar anytime 

How to Use This Feature: 
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Understanding Supervisor Dashboard Widgets 

My Activities Widget: 

 Shows count of YOUR activities by status 

 Click counts to filter your activities 

 Click "Create New Activity" for quick access 

Supervised Activities Widget (Supervisor-Specific): 

 Total Supervised: All activities assigned to you 

 Pending Approval: Activities awaiting YOUR review (PRIORITY) 

 Approved by Me: Activities you've approved 

 Sent Back: Activities you've sent back for revision 

 Click "View Pending Approvals" to go directly to pending activities 

My Workplans Widget (Supervisor-Specific): 

 Total Workplans: Workplans assigned to you 

 In Progress: Active workplans 

 Completion Rate: Average completion percentage 

 Click "View Workplans" to see all workplans 

My Tasks Widget: 

 Shows pending and completed duty instructions 

 Click "View All Tasks" to see duty instructions 

Recent Activities Widget: 

 Shows your 5 most recent activities (yours and supervised) 

 Click any activity to view details 

Team Performance Widget (Supervisor-Specific): 

 Top Performers: Action officers with most approved activities 

 Activities by Status: Distribution of supervised activities 

 Click "View Team Report" for detailed team metrics 

Using Quick Actions 

From Dashboard: 
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 Create New Activity → Opens activity creation form 

 View Pending Approvals → Goes to Supervised Activities (Pending filter) 

 View Workplans → Goes to Workplans page 

 View All Tasks → Goes to Duty Instructions page 

 View Team Report → Goes to Supervised Activity Reports 

Monitoring Your Responsibilities 

Daily Check (Priority Order): 

1. Pending Approval count - Activities awaiting your review (DO THIS FIRST) 

2. My Activities Submitted count - Your activities awaiting approval 

3. Workplan Completion Rate - Track workplan progress 

4. My Tasks - Duty instructions to complete 

5. Team Performance - Identify support needs 

Weekly Review: 

1. Review supervised activity distribution by status 

2. Check workplan completion rates 

3. Identify action officers needing support 

4. Track your own activity progress 

5. Plan upcoming activities and approvals 

How This Feature Appears in Reports: 

Dashboard metrics are derived from your activity data and supervised data, and appear in detailed reports. 

Additional Important Information: 

Tips and Best Practices: 

 Check dashboard daily when you log in 

 Prioritize pending approvals - don't let them accumulate 

 Use quick actions for efficiency 

 Monitor team performance to identify support needs 

 Track your own progress alongside supervisory duties 

 Celebrate team achievements shown in metrics 

Common Mistakes to Avoid: 

 Don't ignore high pending approval counts 
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 Don't neglect your own activities for supervisory duties 

 Don't forget to check workplan completion rates 

 Don't overlook team performance indicators 

Permissions: 

 As Supervisor: You see YOUR data + SUPERVISED data on dashboard 

 Dashboard is personalized to your work and team 

 

Conclusion 

Congratulations! You've completed the AMIS Supervisor Tutorial. You now have comprehensive 

knowledge of all features available to you as a Supervisor. 

Key Takeaways 

Your Dual Role: 

1. As an Implementer: Create and implement your own activities 

2. As a Supervisor: Oversee and approve your team's activities 

Your Responsibilities: 

 Review and approve activities submitted by your team 

 Provide constructive feedback to improve quality 

 Monitor workplan progress and completion 

 Support action officers in achieving objectives 

 Maintain high quality standards 

 Create and implement your own activities 

 Complete duty instructions assigned to you 

Your Capabilities: 

 All Regular User Features: Everything a Regular User can do 

 Approve Activities: Approve activities that meet quality standards 

 Send Back for Revision: Request corrections with detailed feedback 

 Monitor Workplans: Track progress of workplans assigned to you 

 View Enhanced Reports: Access reports on supervised activities 

 Support Your Team: Provide guidance and support to action officers 
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Your Approval Workflow 
SUBMITTED → REVIEW → DECISION 
              ↓          ↓ 
         Check:    APPROVE or SEND BACK 
         - Evidence      ↓              ↓ 
         - Data      APPROVED      ACTIVE 
         - Quality      ↓          (with feedback) 
                    Ready for         ↓ 
                    Evaluation    Revise & Resubmit 

Next Steps 

1. Check Pending Approvals Daily - This is your top priority 

2. Review Thoroughly - Quality control is your responsibility 

3. Provide Constructive Feedback - Help your team improve 

4. Monitor Workplans - Track progress proactively 

5. Support Your Team - Be available for questions and guidance 

6. Lead by Example - Maintain high quality in your own activities 

7. Communicate Regularly - Stay in touch with your team 

Quality Review Checklist 

Before approving any activity, ensure: 

 Completeness: 

 All required fields are filled 

 All required files are uploaded 

 Implementation details are complete 

 Evidence: 

 Photos clearly show the activity 

 Documents are readable and relevant 

 Signing sheets/distribution lists are included 

 Evidence supports the implementation 

 Data Quality: 

 Beneficiary data is realistic and accurate 

 No duplicate beneficiaries 

 Gender and location data is recorded 

 Participant/beneficiary counts match evidence 
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 Cost Information: 

 Actual cost is recorded 

 Cost is realistic for the activity 

 Cost breakdown is provided (if applicable) 

 Alignment: 

 Implementation matches the activity plan 

 Strategic plan linkages are appropriate 

 Location information is accurate 

Feedback Best Practices 

When sending back for revision: 

 Be Specific: 

 List exactly what needs correction 

 Provide clear examples 

 Explain why it matters 

 Be Constructive: 

 Focus on improvement, not criticism 

 Provide guidance on how to fix 

 Offer support and resources 

 Be Encouraging: 

 Acknowledge what was done well 

 Express confidence in their ability to improve 

 Thank them for their work 

 Be Timely: 

 Provide feedback within 1-3 days 

 Don't let activities wait too long 

Getting Help 

If you encounter issues: 
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1. Check this tutorial for guidance 

2. Review error messages carefully 

3. Contact your supervisor for supervisory questions 

4. Contact IT support for technical issues 

5. Refer to other documentation in dev_guide/ folder 

Best Practices Summary 

 Do: 

 Review pending approvals daily 

 Provide specific, constructive feedback 

 Approve activities that meet quality standards 

 Send back activities that need improvement 

 Monitor workplan progress regularly 

 Support your team members 

 Lead by example with your own activities 

 Communicate regularly with your team 

 Celebrate team achievements 

 Document lessons learned 

 Don't: 

 Delay approvals unnecessarily 

 Approve without reviewing evidence 

 Send back without specific feedback 

 Be too lenient or too strict 

 Ignore low workplan completion rates 

 Micromanage your team 

 Neglect your own activities 

 Forget to record costs in your activities 

 Approve activities you haven't reviewed 

System Goal Reminder 

Always remember the primary objective: Monitor and Measure the effectiveness of activities 

implemented and how they contribute to achieving the targets in the plans. 

As a Supervisor, you enable this goal by: 

 Ensuring activities meet quality standards through thorough review 
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 Providing feedback that improves implementation quality 

 Supporting action officers to achieve results 

 Monitoring progress toward workplan objectives 

 Maintaining data quality and integrity 

 Facilitating evidence-based decision making 

Your Impact 

Your role as a Supervisor is crucial to the success of AMIS and the agricultural sector: 

 You ensure quality through thorough review and approval 

 You develop capacity through constructive feedback 

 You enable results by supporting your team 

 You maintain standards that ensure data integrity 

 You contribute to national development goals through effective supervision 

Thank you for your leadership and dedication to agricultural development in Papua New Guinea! 

 

Thank you for using AMIS! 

Document End 

 


